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Creating an interactive PDF eBook in InDesign

E-books are nothing short of a phenomenon on the internet. And it’s not difficult to see why:



They’re cheap to create and distribute; they give ordinary people the opportunity to express themselves; they are an outstanding marketing tool – taking on a life of their own after publication with links, branding, company and product information that can be virally re-distributed.



Download a free copy of an interactive PDF eBook

I have just made a free PDF eBook called How to Market Yourself Online.



Click the button above to download a copy of this PDF as I will be referring to it in this article.

Most eBooks are PDFs. PDFs are easily exportable from Microsoft Word. But if you want complete creative control and interactivity (with not only external links to websites but also an internal navigation system) it is better to use Adobe InDesign to create it. However, if you don’t have InDesign (and it is rather expensive), please read on as most of the points I make here can be applied to all eBooks regardless of the application used to create them.

Why use a PDF?

The PDF format was originally created for storing and editing printed documents and because of this text does not flow to fit the screen. And, because the PDF embeds the fonts you are using, the page elements are pretty much set in stone and look identical on any computer with Acrobat Reader installed. With PDFs, What You See in the application you use to create it Is What You Get when your readers view it and print it.

So, if your readership would like to print your document on a desktop printer or view it on a laptop or desktop computer, PDF is the file type for your eBook!

(For eBooks that are created for handheld devices such as phones and eReaders, ePub is the file type to go for. I will be writing another article about creating ePub documents soon!)

Page format

Page size: Create your eBook with a page size that will fill up a computer screen and print off on a desktop printer without any wasted paper. So, I would choose something like the north american letter size of 8.5″ Ã— 11″ or 216mm Ã— 279mm landscape (that’s 11″ or 279mm wide by 8.5″ or 216mm deep – on it side, otherwise it won’t fill up the screen). Alternatively, you could try the european A4 size landscape if that’s where your audience is. But, it’s the landscape / horizontal format which is key here.



Obviously, you don’t have facing pages in an eBook – there are no left or right pages. Text stretching across the wide page is difficult to read so make sure the text is large and doesn’t run across the full width of the page – or you could go for 2 or 3 column.

Also obviously, leave a few millimeters of margin all around the text so that nothing gets cut off by any of your readers’ printers.

Make every page the same size within your PDF even though it’s possible to have multiple sizes.

Fonts: Pick easy to read fonts. You might be partial to a bit of Comic Sans or Brush Script but would you really want to read more than a couple of paragraphs in them? Trust me, you wouldn’t. Choose a dependable serif for your body text (I went for Bell MT) and a solid unobtrusive sans serif for headings and subheaders (for me, DIN).

Paragraph styles: In order to add some air or white space into the proceedings, I preferred to add space in between the paragraphs rather than indent the first line. Other than the body text Paragraph Styles, here are some others I created to make my eBook.

	Headings
	Subheads
	Bullets
	Blockquotes
	Small text style (for copyright line and credits)


Colors: In order to inject a bit of variety into the gray or black text, I would choose a couple of colors for the headings and links in the document.

Images: Again, to add a little color, choose some images to insert into the eBook’s text. Maybe one for each section head like I did. But keep them small – you don’t want the PDF’s file size to be too big. Images should be RGB JPEGs.



Navigation, branding and header & footer area

The header and footer areas of an eBook are a great way to provide branding and navigational aids to your readers. There are four elements I put on the InDesign Master Page in the header and footer area (although their usage depends on the type of eBook):

	Page number: This is crucial for navigation. In InDesign go, Type > Insert Special Charecter > Markers > Running Page Number, or Cmd/Ctrl-Shift-Option-N. It is depicted as an “A” on the Master Page but gives the page number on every page of your eBook.
	Contents page button: I set the magnification in the button to Inherit Zoom
	Next and previous page buttons: Again, I set the magnification in the button to Inherit Zoom
	Your logo: Great excuse for a bit of publicity for yourself or your company. Make it a button with a hyperlink back to your website.




Cover page and contents page

Make a cover page with an internal link to the contents page. Make the second page a contents page with each section or chapter in the list linking to that section or chapter in the eBook. Add page numbers for reference as well. With this contents page plus the contents page button on every page, your reader is never lost in your document. The reader knows he or she can flick through the eBook, easily finding the bits that they want.

Exporting the document

When exporting the eBook there are several important things to consider:

	File size: Compress the images so they’re not too big and not too small.
	Make sure it has RGB brightness: In InDesign, go Edit > Transparency Blend Space > Document RGB and make sure it is outputted to a RGB destination.
	Make sure all hyperlinks and internal links are working: In the InDesign Export Adobe PDF dialog box under Option: check Optimize for Fast Web View, and under Include: check Non-Printing Objects, Hyperlinks and Interactive Elements.
	File name: Call it by it’s first name. Not something like “EBOOK495-8343Xv22.pdf”.




Security

Once exported and you’re happy with the way it looks (that took me months, by the way, but that’s another story!) there are some super-important things you can do to protect your material from plagiarism. Get Adobe Acrobat Professional, you can download a 30-day free trial, which is OK because you’ll only need it for 5 minutes!

Open your lovely new PDF eBook in Acrobat Pro and go File > Document Properties… or Cmd/Ctrl-D. Click on the Security tab. In the Security Method dropdown menu choose Password Security. Click on the first radio button – “Encrypt all document contents”. Do not check the “Require a password to open the document” check box. But check the “Restrict editing and printing of the document”. Then enter a password and let your readers be able to print the document but not edit it by choosing the relevant options in the two dropdown menus:

Printing allowed: choose high resolution or low resolution, it’s up to you. Changes allowed: none. Do not check “Enable copying of text, images and other content” but check “Enable text access for screen reader devices for the visually impaired”. Click OK, save and you’re done.

Now your readers will be able to read it and print it. But people will find it difficult to copy your work. Try selecting text in Acrobat Reader and copying it once you’ve done this. You can’t. Haha!

Conclusion

As ever, I’m really keen to hear any of your feedback both on my eBook and my method and advice on creating one.






Download my 2 free e-books and 2 free MP3s on running an online business & getting clients
Plus a list of my 12 favorite resources for online business




SOUNDS GOOD?
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				Ralph says			


			April 27, 2010 at 8:48 am
		

		
			
			Thats a good looking ebook.  I may have to try this out for the next one I write.  Thanks for the info.

		


		
		
	
	
	
	

		
		
			
				Latief@AnotherBlogger says			


			May 2, 2010 at 11:17 am
		

		
			
			Great tutorial Rob. But I just a good design admirer 🙂 Thanks for the tips

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			May 2, 2010 at 12:51 pm
		

		
			
			Thanks, Ralph, I’m glad you like the look of the eBook, I hope you find it useful as well. Let me know.

Thanks, Latief, for the comment, and thanks for popping by.

		


		
		
	
	
	
	

		
		
			
				lauren says			


			May 31, 2010 at 6:18 pm
		

		
			
			I really find your posts very helpful. Thank you for spending some time putting this up together and sharing it with us.

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			June 8, 2010 at 1:22 am
		

		
			
			No problem, Lauren

		


		
		
	
	
	
	

		
		
			
				Anonymous says			


			July 7, 2010 at 1:14 pm
		

		
			
			Rob, 

Thank you for explaining the difference between an eBook and a regular PDF. Even Adobe couldn’t tell me what an eBook was. Adobe insists that I need to upgrade to at least InDesign CS4. Do you know if  InDesign CS2 version 4.0.5 will enable me to create an eBook?

Jazzinti

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			July 8, 2010 at 11:30 am
		

		
			
			People use the term ebooks to describe PDFs, ePubs and other file formats – so it’s not always obvious! As far as I am aware, you can only export an ePub from InDesign CS3 and CS4. CS4 has the better controls. I hope this helps.

		


		
		
	
	
	
	

		
		
			
				ken says			


			August 16, 2010 at 2:11 pm
		

		
			
			Creating a ebook is great fun if you know what to write about. You must have a subject. Best to write a ebook about something you are intersted in.

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			August 20, 2010 at 12:22 am
		

		
			
			Absolutely, Ken, write the ebook about something you’re interested in.

		


		
		
	
	



	
	

		
		
			
				BA says			


			August 24, 2010 at 2:28 am
		

		
			
			I’ve never thought about writing my own eBook, but I think school projects could start to be handed in as eBooks.  This only makes sense with all of the online college classes now.

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			August 25, 2010 at 12:28 am
		

		
			
			I guess the ebook will be everywhere soon!

		


		
		
	
	
	
	

		
		
			
				Mark Goodwin says			


			October 20, 2010 at 11:45 am
		

		
			
			Rob

Thank you for this I found most helpful and intend to have a go at this at my first opportunity.

Regards

Mark

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			October 20, 2010 at 2:18 pm
		

		
			
			Thanks, Mark, best of luck with it!

		


		
		
	
	
	
	

		
		
			
				Etoile says			


			October 21, 2010 at 6:05 pm
		

		
			
			This “Tutorial” was supposed to be about: Creating an INTERactive page, not just about promoting Adobe indesign to create a Word document.

You don’t even bother touching on the “Hyperlink”, which is the KEY concept here!

I guess the other “bloggers” missed that point, but were far to eager to please you for providing them that hyperlinked “How to Buy” book of yours….ha ha!

		


		
		
	
	
	
	

		
		
			
				Rob Cubbon says			


			October 21, 2010 at 9:22 pm
		

		
			
			This isn’t a tutorial, it’s not about creating an interactive page (whatever that means), it doesn’t promote InDesign to create a Word document (whatever that means), the good people here who leave messages aren’t necessarily “bloggers”, they aren’t eager to please me (why would they?), I don’t have a “How to Buy” book.

Creating a Hyperlink in InDesign is pretty easy, you do it through the Hyperlink palette in InDesign.

		


		
		
	
	
	
	

		
		
			
				Mark Goodwin says			


			October 22, 2010 at 2:52 am
		

		
			
			@Etoile

For goodness sake what is your problem? Chill out and accept the generosity that is given FREELY!

That's it I've ran out of expletives now!

:-0)

		


		
		
	
	
	
	

		
		
			
				kevin says			


			October 25, 2010 at 6:57 pm
		

		
			
			Thanks for the info. I am always looking to save money and this is very useful as it does not involve buying the costly software, but rather using the free trial.

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			October 26, 2010 at 2:31 pm
		

		
			
			You’ll be really impressed with InDesign, Kevin, let me know how you get on or if you have any questions about how to use it.

		


		
		
	
	



	
	

		
		
			
				Danica says			


			May 17, 2011 at 1:41 am
		

		
			
			How do you create hyperlinks and internal links in your document?

Thanks

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			May 17, 2011 at 8:23 pm
		

		
			
			In InDesign, Danica, use the Hyperlink palette. With the text selected click the Add New Hyperlink button and add the URL (you can specify a character style to make it a different color). Then for internal links, first you have to highlight the text you want to go to and choose New Hyperlink Destination… from the Hyperlink palette drop-down, having done that then set the text you want to link from, Add New Hyperlink, and choose the text anchor you just set. Hope this helps.

		


		
		
	
		
	

		
		
			
				Danica says			


			May 17, 2011 at 9:57 pm
		

		
			
			Great, thanks!  That worked!

		


		
		
	
		
	

		
		
			
				Danica says			


			July 14, 2011 at 4:02 pm
		

		
			
			Should the format for an ebook be different if I’m designing it for a Kindle or iPad vs. for a computer screen? Do I need to create two different documents for the two different formats?

Thank you!

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			July 14, 2011 at 5:07 pm
		

		
			
			It’s different formats, I’m afraid. ePub would work for iPad and can be converted to Kindle however it’s not a very flexible format. The other option is to create Apps specifically for the device.

		


		
		
	
		
	

		
		
			
				Mario says			


			May 11, 2012 at 7:00 pm
		

		
			
			Hi Rob,

Two years later now. Still a lot of people don’t use ebooks, but we are getting there. Maybe slower than expected. Still, Apple just recently showed us more multimediatools in their ibook author application. 

I wan’t to start creating ebooks, many, for clients. As a multimedia guy (video, animation, web) I see great oppurtunity to create enriched ebooks using my own specialties. One thing I miss….is Indesign knowledge.

Do you know if it is possible to create ebooks using indesign with the functions as shown in ibooks. I mean include video, animation, slideshows, notes and quizing? Then export to pc/mac, android and ios devices?

If correctly understood I could export projects twice, iPDF for computers and ePubs for mobile devices.

Any tips?

Thanks!

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			May 12, 2012 at 11:04 pm
		

		
			
			We’ve got to be really careful with the formats here. PDFs can show videos but they are not iBooks (and I don’t think you can turn them into iBooks nor create them in InDesign either). I don’t know what iPDFs are.

Yes, you can export a PDF and an ePub from the same InDesign document. Embedding video in ePub is dodgy.

I hope this helps. There isn’t an over-arching e-book format that does everything and works on every device as far as I can see.

		


		
		
	
	


















	
	

		
		
			
				Justin eisen says			


			August 5, 2011 at 11:15 am
		

		
			
			Can you just e mail these to people as a PDF? 

and there is going to be ALOT of pages in my book formy flient (200+) is there any way to makeit searchable for key pictures/information?? i understand i can use hyperlinks to make it go from the table of contents to the the appropraite page.  Is there other ways more advanced??

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			August 6, 2011 at 11:07 am
		

		
			
			Hi Justin, I’m not sure if I really understand all your questions but I’ll try to help. Yes you can email PDFs. PDFs are searchable – just go Cmd/Ctrl-F in Acrobat Reader. I don’t understand your last question. Hope this helps.

		


		
		
	
	



	
	

		
		
			
				Soo says			


			December 8, 2011 at 9:44 am
		

		
			
			Hey Rob,

This is a really great article you’ve written! I googled to search for articles about using InDesign for creating an ebook. You have been very generous and informative in your delivery and it will be terribly useful for me, as I am interested to start writing ebooks. I just have a few questions that I hope you could help answer? Would creating the cover in Illustrator be an issue and how large or small would the file size be? How would I ‘connect’ the cover to the main text part? And last but not least…for the cover, there will obviously be a front part, but will I need to design the back part too?

Cheers!

Soo.

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			December 8, 2011 at 2:50 pm
		

		
			
			Hello Soo, I’m glad you’ve found this article useful. 

Yes you can import or paste an Illustrator vector into InDesign. It won’t effect the file size considerably, only if the vector was amazingly detailed. In order to “connect” the Illustrator file to the InDesign, that’s just a simple File > Place in ID – or paste, as I say. 

As for “front part” or “back part” I’m not sure if I really understand the question. As they are e-books they don’t really have a cover as such, just the first page of the PDF. You decide if you want a back page. I hope this helps.

Best to look at mine so you can see what I’m talking about:  https://robcubbon.com/free-how-to-market-yourself-online-ebook/

		


		
		
	
	



	
	

		
		
			
				Jeff Colburn says			


			December 25, 2011 at 1:26 am
		

		
			
			Hi Rob,

Thanks for the info. I’ve written several ebooks, but my next project (a photography ebook) requires more control than Word or Publisher, so I’ll use InDesign. You’re tips will be very useful. 

Have Fun,

Jeff

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			December 25, 2011 at 7:34 pm
		

		
			
			No problem, Jeff. InDesign is definitely the way to go in order to create good looking and interactive e-books.

		


		
		
	
	



	
	

		
		
			
				Kirsten says			


			February 26, 2012 at 3:53 am
		

		
			
			Hi.  We are creating a language learning book for print in Indesign. It has the usual book elements and a pile of example text in boxes or in anchored boxes, it also has footnotes and photos.  Its almost ready for print.  After that Im keen to learn how to add audio files and link them to parts of the text and create an epub version so users could click examples and hear the correct way of saying words and phrases, similar to some of the ebooks for children avail for ipads where it can read to you. Do you know if that is doable in Indesign or do we need to create an app?

Your advice is welcomed.

k

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			February 27, 2012 at 1:09 am
		

		
			
			Hello Kirsten, audio files can be uploaded using the Media palette and then played using the button interactivity when something is clicked. 

I don’t think ePub can have audio as it is mainly a text file – I’m not 100% sure on that but I think so. 

This all depends on how you want the resulting e-book to be viewed, what you want it to do and on what devices..

		


		
		
	
	



	
	

		
		
			
				sean says			


			March 4, 2012 at 12:58 pm
		

		
			
			Rob, do you have experience using ibookauthor – the apple program? it sounds pretty user friendly, although the hardware and software necessary to use it are a put-off. I’ve also found Adobe products to be overwhelming – Illustrator, Photoshop… I can use them, but I don’t enjoy it. Last question – with Indesign, is it possible to enable the reader to be able to move things on the pages in the ebook – which is what I’ve seen, and what I wish to do.

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			March 5, 2012 at 12:47 pm
		

		
			
			Hello Sean. I don’t have any experience with ibookauthor. I have been using ID, Illustrator and Photoshop for years so I’m pretty comfortable with them. 

I’m not sure if you can move objects in PDFs. If you can it will be by adding JavaScript into the PDF in Acrobat Pro rather than doing it in InDesign, I think.

		


		
		
	
	



	
	

		
		
			
				Ronda says			


			January 6, 2013 at 2:34 am
		

		
			
			Hi Ron, Thanks for the good info. I’m wondering about what you said about PDF security. I followed your instructions and saved the document. I then opened it in Apple’s Preview app and was able to copy the contents and paste it into another document. I opened the file again in Acrobat Pro and checked the settings. They remain set as you directed. Have you tested this before? Do you know of anything else I can do to prevent copying of content?

		


		
		
	
		
	

		
		
			
				Rob Cubbon says			


			January 7, 2013 at 10:42 am
		

		
			
			Hi Ronda, it’s Rob actually.

Yes, you’re absolutely right, I’ve just checked that and, sure enough, you can copy the text in Apple’s Preview. Obviously the secure PDF isn’t that secure! 

However, my main reason for adding the password is to get rid of that Mac bug that puts a pink bar at the top of the PDF in Acrobat saying that you have to fill out a form whenever there are interactive elements in the PDF. I explain this in more detail here here. 

There’s nothing to stop anyone giving the file out to thousands of people so there really is little security with PDFs anyway. I’m sorry, I don’t know any other way to protect the contents. They are probably more secure on Kindle?

		


		
		
	
	





			



Get free e-books and free MP3s as well as notifications of cool offers and free Kindles. 
A whole toolbox of business resources!
 

I WANT FREE STUFF!


You can unsubscribe anytime.
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				Free: How To Make Passive Income
	Free: Email marketing with AWeber and MailChimp
	Free: An Introduction to WordPress
	Free: Learn Graphics with Adobe Photoshop and Illustrator
	All free courses
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Download free stuff

			Learn how to develop a successful website that brings customers to your business





Sign up for my newsletter and get free How to Market Yourself Online and Starting An Online Business e-books, two MP3s on online business as well as a list of my favorite resources.
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	HELLO! WHAT'S YOUR EMAIL?X

	
		
			It's nice to meet you! I'd love to send you exclusive content that you can't find anywhere else on the blog, and I'll send you free ebooks and MP3s to help you with your online business as well!
		


		Enter your email below, and I'll see you on the inside!

      
       Email is invalid! Please try again.

		Sorry, you can not subscribe at this time.

		
           
           
       		SIGN UP!
		

        
        
        
      

	


 







		